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GroupWise 7 
Support Pack 1 

June 15, 2006

1  Overview
GroupWise® 7 Support Pack 1 provides enhancements for both administrators and end users.

For Administrators

• On Linux*, installation in a Novell® Cluster Services cluster has been simplified.
• On Linux, GroupWise can be installed on PolyServe* Matrix Server.
• Improved global signatures enable administrators to more effectively meet business, legal, or 

regulatory mandates.
• The new Gateway Alias Migration utility converts SMTP gateway aliases into preferred e-mail 

IDs.
• The GroupWise Target Service Agent for File Systems (TSAFSGW) has been improved. On 

NetWare® and Linux, it can determine what types of GroupWise objects are available for 
backup based on the path you provide. In a NetWare cluster, it can identify and back up 
GroupWise data based on virtual server information, rather than physical server information.

• The interactive tutorial in the Windows* client should reduce help desk calls. It also offers 
administrators additional training opportunities for their users from BrainStorm*, Inc., the 
Novell® official end-user training partner.

For End Users

• GroupWise Windows client users should find the interactive tutorial helpful for setting up their 
Home views.

• Cross-Platform client users will appreciate the additional features that have been added to the 
Cross-Platform client.

• WebAccess client dial-up users in low-bandwidth environments will enjoy improved 
performance when using the many new, attractive, and efficient WebAccess features provided 
in GroupWise 7.

• GroupWise users with customers, partners, and colleagues on other e-mail systems can now 
schedule meetings and receive accepted/declined statuses between systems, thanks to the 
availability of iCal support. Compatible e-mail systems include Microsoft* Exchange and 
Lotus* Notes*.

• Outlook* Connector users can now access shared GroupWise Contacts folders from Outlook.
• GroupWise users of mobile devices now have out-of-the-box synchronization capabilities.
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2  GroupWise System Requirements
The system requirements for GroupWise 7 Support Pack 1 are essentially the same as those listed in 
the GroupWise 7 Installation Guide (http://www.novell.com/documentation/gw7/gw7_install/data/
bp8vh01.html#bp8vh01), with the following additional environments now supported:

• PolyServe Matrix Server 3.1 on Linux
• Mac OS X on Intel* (for the Cross-Platform client only, not the WebAccess client)
• VMWare* ESX/GSX (for the agents and the clients)

IMPORTANT: GroupWise system requirements do not apply to GroupWise Mobile Server. For 
GroupWise Mobile Server requirements, see the GroupWise Mobile Server Readme (http://
www.novell.com/documentation/gw7/gmsreadmeus/data/gmsreadmeus.html).

3  NetWare/Windows: Support Pack Installation
• Section 3.1, “NetWare/Windows: Administration Software Installation Instructions,” on page 2
• Section 3.2, “Windows: Client Software Installation Instructions,” on page 3

3.1  NetWare/Windows: Administration Software Installation 
Instructions

IMPORTANT: If you are installing the GroupWise software in a cluster, refer to the GroupWise 7 
Interoperability Guide (http://www.novell.com/documentation/gw7) for cluster-specific installation 
instructions before starting to install the Support Pack.

1 Download the NetWare/Windows GroupWise 7 SP1 Administration compressed executable 
file:

gw701e.exe for English only 
gw701m.exe for multilingual

to a temporary directory on your NetWare or Windows server.
2 Extract the .exe file into a directory at the root of your local drive or to a network server drive 

that can handle long pathnames.
The compressed file contains directory paths that could exceed DOS limits.

3 In Windows, click Start > Run > Browse, then locate the directory where you extracted the SP1 
administration files.

4 Select the setup.exe file, then click OK to run the GroupWise Installation program.
5 Click Create or Update a GroupWise System.
6 Follow the on-screen instructions to create the GroupWise 7 SP1 software distribution 

directory and install the administration and agent software on your test system.
Update the primary domain first. Start the MTA in the primary domain. Then update secondary 
domains, followed by the post offices in each domain. Start each MTA and POA for each 
domain and post office. Then update the other GroupWise agents.
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For additional instructions, refer to the GroupWise 7 Installation Guide on the GroupWise 7 
Documentation Web site (http://www.novell.com/documentation/gw7).

3.2  Windows: Client Software Installation Instructions
1 Download the GroupWise 7 SP1 Windows Client compressed executable file to a temporary 

directory on your workstation:

gw701ce.exe for English only
gw701cm.exe for multilingual

2 Extract the .exe file into a directory at the root of your local drive.
The compressed file contains directory paths that could exceed DOS limits.

3 In Windows, click Start > Run > Browse, then locate the directory where you extracted the SP1 
client files.

4 Select the setup.exe file, then click OK to run the GroupWise client Setup program.
5 Follow the on-screen instructions to install the SP1 client software on your workstation.

4  Linux: Support Pack Installation
• Section 4.1, “Linux: Administration Software Installation Instructions,” on page 3
• Section 4.2, “Linux: Cross-Platform Client Software Installation Instructions,” on page 4
• Section 4.3, “Macintosh: Cross-Platform Client Software Installation Instructions,” on page 4

4.1  Linux: Administration Software Installation Instructions

IMPORTANT: If you are installing the GroupWise software in a cluster, refer to the GroupWise 7 
Interoperability Guide (http://www.novell.com/documentation/gw7) for cluster-specific installation 
instructions before starting to install the Support Pack.

1 Download the GroupWise 7 SP1 Administration compressed tar file to a temporary directory 
on your Linux server:

gw701lnxe.tgz for English only
gw701lnxm.tgz for multilingual

2 In a terminal window at your Linux server, change to the temporary directory, then use the 
following commands to uncompress and untar the downloaded file:
tar -xz  filename.tgz

The result is a directory named gw701lnxe or gw701lnxm.
3 Change to the new directory.
4 Become root by entering sux and the root password.
5 Use the following command to start the GroupWise Installation program:
./install

6 Click Create or Update a GroupWise System.
7 Follow the on-screen instructions to create the GroupWise 7 SP1 software distribution 

directory and install the administration and agent software.
3
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Update the primary domain first. Start the MTA in the primary domain. Then update secondary 
domains, followed by the post offices in each domain. Start each MTA and POA for each 
domain and post office. Then update the other GroupWise agents.
When you use the Linux GroupWise Installation program to install a Support Pack, use the 
Install option to install the updated RPM for each agent. Typically, you do not need to use the 
Configure option after installing updated agent software, if the agent configuration has not 
changed since the previous installation. (For an exception to this procedure, see Section 7.3.1, 
“Run Configure When Updating the Agents,” on page 12). If you encounter a problem starting 
the updated agent, use the Configure option to update the configuration information.
For additional instructions, refer to the GroupWise 7 Installation Guide on the GroupWise 7 
Documentation Web site (http://www.novell.com/documentation/gw7).

4.2  Linux: Cross-Platform Client Software Installation 
Instructions

1 Download the GroupWise 7 SP1 Client compressed tar file to a temporary directory on your 
Linux workstation:

gw701clnxe.tgz for English only
gw701clnxm.tgz for multilingual

2 In a terminal window at your Linux workstation, change to the temporary directory, then use 
the following command to uncompress and untar the downloaded file:
tar -xz filename.tgz

The result is a directory named gw701clnxe or gw701clnxm.
3 Change to the new directory.
4 Run the GroupWise Setup program to install the GroupWise Cross-Platform client software:
./install

5 To start the Cross-Platform client after installation, click the GroupWise icon on your Linux 
desktop.

4.3  Macintosh: Cross-Platform Client Software Installation 
Instructions

1 Download the GroupWise 7 SP1 Client file to a temporary directory on your Macintosh* 
workstation:

gw701cmace.dmg for English only; Mac OS X
gw701cmacm.dmg for multilingual; Mac OS X
gw701cmacie.dmg for English only; Mac OS X on Intel
gw701cmacim.dmg for multilingual; Mac OS X on Intel

2 At your Macintosh workstation, browse to the file you downloaded.
3 Double-click the file to install the GroupWise Macintosh client.
4 To start the Cross-Platform client after installation, click the GroupWise icon on your 

Macintosh desktop.
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5  Installation Issues
• Section 5.1, “General Installation Issues,” on page 5
• Section 5.2, “NetWare/Windows Installation Issues,” on page 6
• Section 5.3, “Linux Installation Issues,” on page 6

Installation issues for individual GroupWise components are located under the heading for each 
component.

5.1  General Installation Issues
• “Version Compatibility” on page 5
• “GroupWise 7 Reinstallation” on page 5
• “WebAccess and Monitor on the Same Web Server” on page 5
• “Web Clipping Application (PQA) Support with WebAccess and Monitor” on page 6
• “Additional Installation Issues” on page 6

5.1.1  Version Compatibility

If you install GroupWise on multiple platforms, or if you run multiple versions (for example, 
GroupWise 6.5 and GroupWise 7 in the same GroupWise system), refer to the GroupWise Version 
Compatibility appendix in the GroupWise 7 Installation Guide (http://www.novell.com/
documentation/gw7) to make sure that the combinations you are using are supported. 

For example, you cannot run a GroupWise 7 client against a GroupWise 6.5 or earlier post office. 
Earlier POAs cannot support later GroupWise clients. However, you can run a GroupWise 6.5 or 
earlier client against a GroupWise 7 POA.

Also, you cannot run the GroupWise 6.5 or earlier snap-ins to ConsoleOne® to access GroupWise 7 
databases or eDirectoryTM objects. You can use Admin Lockout Settings under Tools > GroupWise 
System Operations > System Preferences  to specify the required version of the ConsoleOne snap-
ins for each domain as needed.

5.1.2  GroupWise 7 Reinstallation

If you install GroupWise 7 components from a software distribution directory located on your local 
drive or a network drive and then try to update those components by installing from a CD, the 
installation fails by erroneously prompting for a disk:

Please insert the disk: 1

Uninstall the existing software, then install from the CD.

5.1.3  WebAccess and Monitor on the Same Web Server

The WebAccess Application, WebPublisher Application, and Monitor Application share a common 
library. If you are updating from an earlier GroupWise version and if you run these applications on 
the same Web server, you must update all three before any of them can work properly.
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5.1.4  Web Clipping Application (PQA) Support with WebAccess and Monitor

Palm OS* devices are no longer supported in GroupWise 7. However, the Installation program still 
offers the opportunity to configure this feature. If you have been using a PQA in an earlier version of 
GroupWise, you can continue to do so, but it is no longer a supported feature.

5.1.5  Additional Installation Issues

Platform-specific installation issues are listed in separate sections below. Installation issues for 
individual GroupWise components are located under the heading for each component.

5.2  NetWare/Windows Installation Issues
• “Software Distribution Directory Dependency” on page 6
• “Problem Installing from a Windows XP Service Pack 2 Machine” on page 6

5.2.1  Software Distribution Directory Dependency

When you create a new system and you are prompted for software to copy to the software 
distribution directory, select at least the agent and client software. The GroupWise Installation 
program launches the Agent Installation program and the Client Installation program. It currently 
must run those programs from the software distribution directory.

5.2.2  Problem Installing from a Windows XP Service Pack 2 Machine

When installing any GroupWise agent (Post Office Agent, Message Transfer Agent, Internet Agent, 
WebAccess Agent, Monitor Agent) to a NetWare server from a Windows XP machine where 
Service Pack 2 has been installed, you must have the Novell ClientTM 4.90 SP2 or later installed on 
the Windows machine. If you have an earlier Novell Client, the GroupWise Installation program 
claims that it cannot find some of the directories to which you want to install software.

5.3  Linux Installation Issues
• “Linux Text-Based Installation Program Compatibility with ssh on Windows” on page 6
• “Upgrading from an Incomplete Software Distribution Directory” on page 6
• “Moving a GroupWise 4.1 System from NetWare or Windows to Linux” on page 7

5.3.1  Linux Text-Based Installation Program Compatibility with ssh on Windows

The text-based GroupWise Installation program does not run on all Windows versions of ssh. An 
open source product named Putty that can be downloaded from the Internet free of charge is 
compatible with the text-based GroupWise Installation program.

5.3.2  Upgrading from an Incomplete Software Distribution Directory

Because all GroupWise components on a server must be updated at the same time, if you are 
installing GroupWise 7 from a software distribution directory that does not contain RPMs for all the 
components installed on the server, you receive the following error:

Install failed for an unknown reason (7)
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The GroupWise 7 component cannot be updated because its RPM is not present in the software 
distribution directory. You can use the GroupWise 7 Administrator for Linux CD to update the 
server, then use Configure Administration to create a complete software distribution directory.

5.3.3  Moving a GroupWise 4.1 System from NetWare or Windows to Linux

The Update section of the GroupWise 7 Installation Guide provides instructions for moving from 
NetWare or Windows to Linux. If you are moving post offices and domains belonging to a 
GroupWise 4.1 system, you might need to manually rename the domain database (wpdomain.db) 
from uppercase to lowercase, along with all .dc files. In addition, subdirectories in post office and 
domain directories might need to be renamed to lowercase.

6  Administration Issues
• Section 6.1, “General Administration Issues,” on page 7
• Section 6.2, “NetWare/Windows Administration Issues,” on page 9
• Section 6.3, “Linux Administration Issues,” on page 10

6.1  General Administration Issues
• “ConsoleOne Snap-In Version Compatibility” on page 7
• “Text Version of Global Signatures” on page 7
• “Images in Global Signatures” on page 8
• “Global Signatures and Flat Forwarding through the Internet Agent” on page 8
• “-601 SPI Exception Displays during Alias Migration” on page 8
• “Server Names” on page 8
• “Identity Manager Version Compatibility” on page 8
• “Server-Based Anti-Virus Software” on page 8

6.1.1  ConsoleOne Snap-In Version Compatibility

After a domain has been updated to GroupWise 7, do not administer that domain with earlier 
versions of the GroupWise snap-ins to ConsoleOne. Doing so could result in the unintentional 
creation of duplicate e-mail IDs. 

The e-mail ID indexing scheme has been changed to allow the same e-mail ID to be used in different 
Internet domains within the same GroupWise system. This was prevented by the previous indexing 
scheme. Because the check for uniqueness now works differently, you must use the GroupWise 7 
version of the ConsoleOne snap-ins when administering a GroupWise 7 domain to prevent the 
possibility of duplication.

6.1.2  Text Version of Global Signatures

In the original release of GroupWise 7, the text version of a global signature was generated 
automatically from the HTML version; you did not have any control over it. In GroupWise 7 SP1, 
you can display and edit the text version as well as the HTML version. If you created global 
7
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signatures in the original version of GroupWise 7, you should verify that the text version is what you 
want and modify it as needed. 

1 In ConsoleOne, click Tools > GroupWise System Operations > Global Signatures.
2 Select a global signature, then click Edit.
3 Modify the text version as needed.

For example, if the HTML version included an image, such as your company logo, you might 
want to add text to take the place of the image, such as the name of your company.
Click OK to save your changes.

4 Repeat this procedure for each global signature.

6.1.3  Images in Global Signatures

You might encounter a problem including an image file in a global signature if the path to the image 
is too long. This is a Java* problem. The easiest workaround is to move the image to a location with 
a shorter path. Another solution on Windows is to set the TMP environment variable to c:\temp 
before starting ConsoleOne.

6.1.4  Global Signatures and Flat Forwarding through the Internet Agent

If you enable global signatures, it disables flat forwarding through the Internet Agent because the 
signature is appended to each message. As an administrator, you must choose which is more 
important in your GroupWise system, global signatures or flat forwarding.

6.1.5  -601 SPI Exception Displays during Alias Migration

If the E-Mail Address field on the General page of a User object needs to be changed as a result of 
the information in the gateway alias, and if the User object cannot be found, a -601 SPI 
Exception displays and is written to the Alias Migration utility log file. This situation can arise 
when the association between the eDirectory object and the GroupWise object is broken for some 
reason. The association can be reestablished using Tools > GroupWise Utilities > GW / eDirectory 
Association > Associate Objects.

6.1.6  Server Names

When filling in a UNC Path field in ConsoleOne, you must specify the server name. You cannot use 
an IP address or DNS hostname.

6.1.7  Identity Manager Version Compatibility

Do not run an existing DirXML® or Identity Manager driver dated earlier than July, 2005, against a 
GroupWise 7 system.

GroupWise 7 requires the latest version of the GroupWise Identity Manager driver. Older drivers are 
not compatible. You can download the required version of the GroupWise driver from the Novell 
Identity Manager Patches Web site (http://support.novell.com/filefinder/20560/index.html).

6.1.8  Server-Based Anti-Virus Software

If you run server-based anti-virus software, you should configure it so that it does not scan 
GroupWise directory structures such as domains and post offices where file locking conflicts can 
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create problems for the GroupWise agents. If you need virus scanning on GroupWise data, check the 
GroupWise Partner Products page (http://www.novell.com/partnerguide/p100031.html) for 
compatible products.

6.2  NetWare/Windows Administration Issues
• “Directory Names and Filenames” on page 9
• “GWTSA and Duplicate Source Directories” on page 9
• “Quotas on NSS Volumes” on page 9
• “TurboFat Compatibility” on page 9

6.2.1  Directory Names and Filenames

All directory names in paths to GroupWise domains and post offices can consist of up to 8 
characters. 

Filenames can also consist of up to 8 characters, with extensions of up to 3 characters. Do not use 
long filenames for any files used by any GroupWise components. This requirement applies even to 
files that are not specific to GroupWise (such as SSL certificates and key files).

6.2.2  GWTSA and Duplicate Source Directories

The GroupWise Target Service Agent (GWTSA) handles situations where the same directory names 
are used on different volumes to back up by numbering the instances. For example:

Original GWTSA 
GroupWise System/[Dom]Provo2:
GroupWise System/[Dom]Provo2:

Support Pack GWTSA 
GroupWise System/1[DOM]Provo2:
GroupWise System/2[DOM]Provo2

Each instance is numbered and DOM is in all uppercase letters. After updating GWTSA with 
GroupWise 6.5 Support Pack 1 or later, you must re-create your backup jobs because the path has 
changed.

6.2.3  Quotas on NSS Volumes

If you use NSS volumes with quotas turned on, then you must turn on quotas on all GroupWise 
directories. Otherwise, you will receive No Disk Space errors.

6.2.4  TurboFat Compatibility

If you see E811 errors on the POA or the GroupWise client, a possible cause is that TurboFat is 
corrupting GroupWise database pointers. The solution is to turn off TurboFat.

• To turn off TurboFat on NetWare 5.x servers, use turbodis.nlm.
• To turn off TurboFat on NetWare 6.x servers, use tdis600.nlm.

These NLMTM programs disable TurboFat at startup.
9
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6.3  Linux Administration Issues
• “NFS Not Supported” on page 10
• “Pathnames and Filenames in Lowercase” on page 10
• “Backup/Restore Area Path on Linux” on page 10
• “Unavailable Administration Features” on page 10

6.3.1  NFS Not Supported

Because of long-standing file lock issues with NFS*, you cannot use an NFS mount to mount a 
server file system where your GroupWise system is located to a workstation where you are running 
ConsoleOne. We recommend using an SMB mount instead.

6.3.2  Pathnames and Filenames in Lowercase

All directory names in paths to GroupWise domains and post offices should consist of lowercase 
letters. Filenames should also consist of lowercase letters. There are no length restrictions.

6.3.3  Backup/Restore Area Path on Linux

When you set up a backup/restore area (Tools > GroupWise System Operations > Restore Area 
Management > Create) for a post office that is serviced by a Linux POA, put a Linux path in the 
UNC Path field. The contents of the Linux Path field are not currently being used.

6.3.4  Unavailable Administration Features

GroupWise 7 administration on Linux does not include the following features that are available in 
GroupWise 7 on NetWare and Windows:

• Import/Export utility in ConsoleOne
• Document Properties Management feature in ConsoleOne

7  Agent Issues
• Section 7.1, “General Agent Issues,” on page 10
• Section 7.2, “NetWare/Windows Agent Issues,” on page 12
• Section 7.3, “Linux Agent Issues,” on page 12

7.1  General Agent Issues
• “New View Files Now Overwrite Existing View Files” on page 11
• “POA Indexing Limitations” on page 11
• “Number of Client/Server Users Incorrect” on page 11
• “SOAP Port Number Not Replicated by the Original GroupWise 7 ConsoleOne Administrator 

Snap-In” on page 11
• “Evolution Compatibility with the POA and SOAP” on page 11
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7.1.1  New View Files Now Overwrite Existing View Files

When you update the POA software, updated view files are  copied to the software distribution 
directory but not to post offices. This maintains any customizations you might have made in the 
view files. When you use the Refresh Views option under Tools > GroupWise Utilities > System 
Maintenance in ConsoleOne, the post office view files are updated from the software distribution 
directory. If you have created custom view files with the same names as standard view files, you 
must create backup copies so that your customized view files are not lost in the refresh process. 
After you refresh the views, you must restore your customized view files to the post office.

7.1.2  POA Indexing Limitations

The POA’s QuickFinderTM indexing feature does not currently index PDF files or OpenOffice files.

7.1.3  Number of Client/Server Users Incorrect

On the Status page of the POA Web console, the C/S Users field might not display the correct 
number of users. Click the number, then return to the Status page to display the correct number of 
users.

7.1.4  SOAP Port Number Not Replicated by the Original GroupWise 7 ConsoleOne 
Administrator Snap-In

If you enabled SOAP in the original GroupWise 7 release, and if you changed the SOAP port 
number from its default of 7191, this information was not correctly replicated from the domain 
database to which ConsoleOne was attached to the post office database used by the POA for its 
configuration information. As a result, SOAP e-mail clients that relied on POA redirection 
(ngwnameserver) were not able to connect to the proper POA unless the correct IP address and 
port number were provided when starting the client.

In GroupWise 7 SP1, successful POA redirection is critical to proper functioning of GroupWise 
Mobile Server. If you enabled SOAP in GroupWise 7 and changed the port number, you need to 
force the port number to replicate from the domain database to the post office database. 

1 Install the SP1 GroupWise Administrator snap-in to ConsoleOne.
2 In ConsoleOne, browse to and right-click the POA object.
3 Click GroupWise > Agent Settings.
4 Deselect Enable SOAP, then click Apply.
5 Select Enable SOAP, then click OK.
6 Repeat this procedure for each POA in your GroupWise system.

By manually modifying the SOAP information, the SOAP information, including the port number, 
is written to the domain database and then properly replicated to the post office database so that 
redirection works properly for SOAP clients.

7.1.5  Evolution Compatibility with the POA and SOAP

Users might experience problems using EvolutionTM to connect to their GroupWise mailboxes if they 
are using Evolution 2.6.0 or earlier. In addition, earlier versions of Evolution can cause high 
utilization on GroupWise servers. To encourage users to update to the latest version of Evolution, 
you can use the /evoversion switch to configure the POA to block versions of Evolution that are 
11
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earlier than the specified version. For example, if you want the POA to block older versions of 
Evolution starting with 2.6.0, you would use the following switch:

NOTE: In Support Pack 1, this switch blocks all versions of Evolution. It is currently designed for 
use on a post office where you want SOAP enabled but you do not want Evolution users to access 
the post office. Future versions of Evolution will return version information that will enable this 
switch to be more selective in allowing certain Evolution versions and not others.

7.2  NetWare/Windows Agent Issues
• “Potential CAP Port Conflict” on page 12

7.2.1  Potential CAP Port Conflict

By default, the POA uses 1026 for its CAP (Calendar Access Protocol) port. On some Windows 
2000 servers, port 1026 is already used by the Windows Task Scheduler or other Windows service. 
If this occurs, configure the POA to use a different CAP port using the /capport switch in the POA 
startup file.

7.3  Linux Agent Issues
• “Run Configure When Updating the Agents” on page 12
• “Non-root Agents on Open Enterprise Server for Linux Support Pack 2” on page 12
• “POA SOAP Protocol on Open Enterprise Server for Linux” on page 13
• “libXm.so.3 Error” on page 13

7.3.1  Run Configure When Updating the Agents

Normally, when you update your agent software with a Support Pack, you can use the Install Agents 
option in the GroupWise Installation program to install the updated agent software, but you do not 
need to use the Configure Agents option because  your agents are already configured. However, in 
Support Pack 1, you should use Configure Agents after updating the agent software in order to 
obtain the updated grpwise script.

7.3.2  Non-root Agents on Open Enterprise Server for Linux Support Pack 2

On Novell Open Enterprise Server SP2, services such as IMAP and IMAP SSL, which require port 
numbers below 1025, cannot be initiated or restarted after the GroupWise agents are running as a 
non-root user. To initiate or restart those services, you must manually stop the services and then 
restart the GroupWise agents.

This also applies to SUSE® Linux Enterprise Server 9 SP3, the version of SUSE Linux that is 
bundled with OES SP2.

NetWare 
and 
Windows:

/evoversion-2.6.1

Linux: --evoversion 2.6.1
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7.3.3  POA SOAP Protocol on Open Enterprise Server for Linux

On OES Linux SP1, the Linux POA does not currently support the SOAP protocol when running as 
a non-root user. However, it does support the SOAP protocol when running as root. 

On OES Linux SP2, the Linux POA does support the SOAP protocol when running as a non-root 
user, as well as when running as root.

7.3.4  libXm.so.3 Error

If you try to start the Linux POA or MTA using the --show switch on a server where The X Window 
System* and Open Motif* are not running, you receive the following error:

libXm.so.3: cannot open shared object file
: no such file or directory

To resolve the error, start The X Window System and Open Motif before starting the POA or MTA 
with the --show switch. If you start the POA or MTA without the --show switch, you can use the 
agent's Web console to monitor the agent from your Web browser.

8  Client Issues
• Section 8.1, “Windows Client Issues,” on page 13
• Section 8.2, “Cross-Platform Client Issues,” on page 16

8.1  Windows Client Issues
• “Error Messages When You Install GroupWise Windows Client” on page 14
• “Error When Installing on Windows 2000” on page 14
• “Windows XP Service Pack 2” on page 14
• “Missing Global Signatures on Empty Messages” on page 14
• “Limited iCal Interoperability with External Systems” on page 14
• “Can't Set a Primary Archive Computer” on page 14
• “Can’t Administer Distribution Lists in Caching Mode” on page 15
• “Screen Flickers When Scrolling a Message” on page 15
• “Can't Switch Modes Using Microsoft Anti-Spyware” on page 15
• “Address Books Do Not Display in GroupWise When Installing GroupWise After Outlook 

2003” on page 15
• “Notify Alarms Disappear for Appointments” on page 15
• “Updated JAWS Script Available” on page 15
• “Spyware Detection Software Causes Installation to Not Work” on page 15
• “VMWare and Proxy” on page 15
• “Word List Not Moved” on page 16
13
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8.1.1  Error Messages When You Install GroupWise Windows Client 

If you install the GroupWise Windows client with Outlook XP already installed, an error message 
appears:

Either there is no default mail client or the current mail client 
cannot fulfil the messaging request. 
Please run Microsoft Outlook and set it as the default mail client.

In addition, if you open the Address Book, the GroupWise client crashes.

To fix the problem run win32\wms\nt\us\wms.exe from the GroupWise installation 
directory, then restart the client.

8.1.2  Error When Installing on Windows 2000

When installing GroupWise on a Windows 2000 operating system, you might receive the following 
error:

The dynamic link library MSVCP60.dll could not be found in the 
c:\path  

To resolve the problem, install any other software before installing GroupWise.  Although 
msvcp60.dll  is installed with GroupWise, it is not detected on some systems.

8.1.3  Windows XP Service Pack 2

Installing Windows XP Service Pack 2 enables the Windows Firewall by default. The default 
Windows Firewall configuration blocks UDP (User Datagram Protocol). GroupWise is dependent 
on UDP for several key features such as listing new messages in your Mailbox, displaying 
notifications, and performing Busy Searches. To reconfigure the Windows Firewall so that it does 
not interfere with GroupWise functionality, follow the instructions in TID 10094089 in the Novell 
Support Knowledgebase (http://support.novell.com/search/kb_index.jsp).

8.1.4  Missing Global Signatures on Empty Messages

If you send a message with a subject only (no message body), a global signature is not appended. 
This is working as designed. The presence of a global signature on a message with an empty 
message body would prevent the Internet Agent /flatfwd switch from functioning correctly. 

8.1.5  Limited iCal Interoperability with External Systems

GroupWise might not handle iCal attachments correctly if they are received from a non-GroupWise 
external system. 

In particular, iCal appointments sent from non-GroupWise external systems (except Microsoft* 
Exchange) display as all-day appointments instead of All Day Events. Because of this, such 
appointments display in the Appointment pane instead of the All-Day-Events pane.

8.1.6  Can't Set a Primary Archive Computer

Currently there is no way to set one computer as a primary archive. This can result in multiple 
archives if you use GroupWise on different computers.
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8.1.7  Can’t Administer Distribution Lists in Caching Mode

In Online mode, if you have been granted rights to modify a distribution list, you can edit that 
distribution list in the GroupWise Address Book. In Caching mode, you cannot edit the distribution 
list in the GroupWise Address Book. However, if you do into the Address Selector in a new 
message, you can administer the distribution list from there.

8.1.8  Screen Flickers When Scrolling a Message

If you use ClearType to smooth the edges of screen fonts and have an LCD display, your screen 
might flicker when scrolling in a text message.

8.1.9  Can't Switch Modes Using Microsoft Anti-Spyware

If you are using Microsoft's Anti-Spyware software, and you try to switch modes, GroupWise does 
not close. You must manually close GroupWise to switch modes. 

8.1.10  Address Books Do Not Display in GroupWise When Installing GroupWise 
After Outlook 2003

The address books do not display in GroupWise if you install GroupWise for the first time after you 
have installed Outlook 2003. To resolve the problem, uninstall Outlook 2003 before you install 
GroupWise for the first time.

8.1.11  Notify Alarms Disappear for Appointments

After your account has been moved from one post office to another, your Notify alarms disappear 
for appointments. To get your Notify alarms back, you need to re-create all the alarms manually. For 
information on setting alarms for appointments, see the GroupWise client help.

8.1.12  Updated JAWS Script Available

Users of the JAWS* screen reader should install the new JAWS script available in GroupWise 7. 
Follow the instructions in the \client\jaws\gw_jaws_readme.txt file to install the JAWS 
script and other files on your workstation. This JAWS script includes Section 508 accessibility 
defect fixes that have occurred since the script was updated for GroupWise 6.5 Support Pack 3.

8.1.13  Spyware Detection Software Causes Installation to Not Work

If you have spyware detection software installed on your Windows computer, the GroupWise client 
for Windows might not install properly. Disable the spyware detection software before you install 
the GroupWise client for Windows.

8.1.14  VMWare and Proxy

If  you run the GroupWise Windows client in a VMWare virtual machine, you might receive an 8503 
error when you try to proxy to another user’s mailbox or display a Multi-User Calendar. To 
eliminate this problem,  you need to disable the VMWare adaptors on your Windows workstation.

1 Right-click My Network Places, then click Properties.

In the list of LAN connections, you see one or more VMWare adapters.
2 Right-click each adapter, then click Disable.
15
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8.1.15  Word List Not Moved

With GroupWise 7.0.1, the default word list is now installed at c:\documents and 
settings\user\Local Settings\Application Data\GroupWise\wt61us.uwl. 
Because of this GroupWise does not find previous versions of the word list. If you have added words 
to your word list you need to copy the word list from c:\wt61us.uwl to  C:\documents and 
settings\user\Local Settings\Application 
Data\GroupWise\wt61us.uwl.

8.2  Cross-Platform Client Issues
• “Items Forwarded from the GroupWise Connector for Outlook Do Not Open” on page 16
• “Running as root in Caching Mode” on page 16
• “Mailbox Size Limits Not Recognized” on page 16
• “Bold Not Displaying on Macintosh” on page 16
• “Archiving Over the Network” on page 16
• “No Progress Bar Displayed When a Database Is Rebuilt” on page 17
• “Focus Is in the Wrong Place When Creating a Reply on Macintosh” on page 17
• “WebRenderer Not Available on Mac OS X on Intel” on page 17

8.2.1  Items Forwarded from the GroupWise Connector for Outlook Do Not Open

If you receive an item that was forwarded from the GroupWise Connector for Outlook, the item does 
not open in the Macintosh version of the Cross-Platform client.

8.2.2  Running as root in Caching Mode

If you run the Cross-Platform client in Caching mode as root on Linux, you might encounter 
synchronization problems with your master mailbox when you next run as a regular user. If pending 
requests from the root session remain when you log in as a regular user, regular user requests get 
backed up behind the root requests, which cannot be processed while you are logged in as a 
regular user. To resolve any problems, run the client as root again so that all messages are 
synchronized, then run as a regular user thereafter to prevent further problems.

8.2.3  Mailbox Size Limits Not Recognized

The Cross-Platform client does not recognize the mailbox size limits set in ConsoleOne (Tools > 
GroupWise Utilities > Client Options > Send > Disk Space Management).

8.2.4  Bold Not Displaying on Macintosh

If you have installed Microsoft Office or Internet Explorer on your Macintosh, new messages might 
not display as bold in your mailbox. To resolve the problem, disable your user fonts, which are 
typically duplicates of your system fonts, or update to JVM* 1.4.2 Update 1 or later.

8.2.5  Archiving Over the Network

Archiving with the Cross-Platform client can only be done to your local computer hard drive. 
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8.2.6  No Progress Bar Displayed When a Database Is Rebuilt

When prompted to rebuild your database, there is no progress indicator displayed during the rebuild 
process.

8.2.7  Focus Is in the Wrong Place When Creating a Reply on Macintosh

When you click Reply on Macintosh, you cannot just type the message. You must move the mouse 
cursor to the message body window of the reply message before you can start typing. 

8.2.8  WebRenderer Not Available on Mac OS X on Intel

The improved rendering of HTML in the WebAccess client is not available on Mac OS X on Intel 
because the WebRenderer* product that has been incorporated into GroupWise is not yet available 
for Mac OS X on Intel.

9  WebAccess Issues
• Section 9.1, “General WebAccess Issues,” on page 17
• Section 9.2, “NetWare/Windows WebAccess Issues,” on page 21
• Section 9.3, “Linux WebAccess Issues,” on page 25

9.1  General WebAccess Issues
• “WebAccess 7 Compatibility with Older Versions of WebAccess” on page 18
• “WebAccess Compatibility with Virtual Office 1.5 and Earlier” on page 18
• “WebAccess Compatibility with Novell exteNd” on page 18
• “Browser Cache Issue” on page 18
• “Login Page Reappears after Successful Login” on page 19
• ““Login Is Not Current” Error” on page 19
• “Pop-Up Blocker Issue” on page 19
• “Recommendation for Tomcat Memory Allocation (Heap Size)” on page 19
• “Preventing Web Server Directory Browsing” on page 19
• “Preventing Unauthenticated Template Access” on page 19
• “Updates to WebAccess Templates” on page 20
• “GroupWise 6.5 Frame Templates No Longer Supported” on page 20
• “All-Day Events on a Wireless Device” on page 20
• ““The Page Cannot Be Displayed” Error” on page 20
• “Blank WebAccess Address Book on Internet Explorer” on page 21
• “Folder List Expansion Problem in Safari on Macintosh” on page 21
• “Document Viewer Agent Cache Compatibility” on page 21
• “Document Viewer Agent /template Switch” on page 21
17
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9.1.1  WebAccess 7 Compatibility with Older Versions of WebAccess

If you have more than one WebAccess Agent in your GroupWise system, you do not need to update 
all of them to GroupWise 7 at the same time. The GroupWise 7 WebAccess Application is 
compatible with older versions of the WebAccess Agent. However, users in post offices with an 
older default WebAccess Agent do not have all of the features available to users in post offices with 
a default GroupWise 7 WebAccess Agent. For more information, see Taking Advantage of Some of 
the New GroupWise 7 WebAccess Features While Still Running GroupWise 6.5 (http://
www.novell.com/coolsolutions/feature/15667.html).

9.1.2  WebAccess Compatibility with Virtual Office 1.5 and Earlier

If you access the WebAccess client through Virtual Office 1.5 or earlier, you might see the old 
WebAccess client interface rather than the new one. To resolve this problem, see TID 10098412 in 
the Novell Knowledgebase (http://support.novell.com/search/kb_index.htm).

9.1.3  WebAccess Compatibility with Novell exteNd

Before GroupWise 7, WebAccess stored its default user interface files in the following directory on 
the Web server:

tomcat_root/webapps/gw/WEB-INF/classes/com/novell/webaccess/
                                                      templates/frames

In GroupWise 7, the user interface files are stored in the css subdirectory of templates rather than 
the frames subdirectory.

If you have exteNdTM portlets configured to use WebAccess, you must copy some of the exteNd 
template files from the frames directory into the css directory. Refer to the Novell exteNd 
documentation (http://www.novell.com/documentation/extend5/index.html) to determine which 
exteNd template files you should copy to the css directory. 

IMPORTANT: Do not copy the entire contents of the frames directory into the css directory; 
this would damage the new GroupWise 7 WebAccess user interface.

In addition, modify the WebAccess URL in the exteNd Portal Preferences from:

http://Web_server_address/servlet/webacc

to:

http://Web_server_address/gw/webacc

9.1.4  Browser Cache Issue

After the WebAccess software has been updated, users’ browsers may pull old WebAccess files 
from the local cache rather than using the updated files that have just been installed. The results are 
unpredictable, including not being able to compose an item, reply, and so on. To resolve such 
problems, users need to clear the browser cache and then log in to the WebAccess client again.
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9.1.5  Login Page Reappears after Successful Login

If the WebAccess login page appears in one or more of the frames (for example, the Folder list or the 
Item list) after a WebAccess user has successfully logged in, the user is probably accessing 
WebAccess through one or more proxy servers.

To prevent this problem:

1 In ConsoleOne, right-click the WebAccess Application object (GroupWiseWebAccess), then 
click Properties.

2 Click Application > Security, then deselect Use Client IP in Securing Sessions. 
For information about this option, click Help on the Environment page.

3 Click OK to save the change.

9.1.6  “Login Is Not Current” Error

If you are already logged in to the WebAccess client and you try to log in again without logging out 
first, you receive the “Login In Not Current” error. This is working as designed for security 
reasons.

9.1.7  Pop-Up Blocker Issue

Very occasionally, a pop-up blocker can prevent you from opening messages in the WebAccess 
client. If this happens, you can turn off the pop-up blocker or use a different one. Many pop-up 
blockers are available.

9.1.8  Recommendation for Tomcat Memory Allocation (Heap Size)

If you are using the Tomcat servlet engine with GroupWise WebAccess, the maximum memory 
allocation (heap size) for Tomcat should be at least 128 MB. The maximum memory allocation is set 
by using the -Xmx parameter when starting Tomcat (for example, -Xmx128m).

9.1.9  Preventing Web Server Directory Browsing

If your Web server is configured to allow directory browsing, it is possible for a user to access the /
com directory of your Web server and browse downward from there. There is no confidential 
information located in any of the directories that are accessible in this manner. 

However, if you want to prevent access, you can change the configuration of your Web server. For 
example, if you are using Apache, you can modify the httpd.conf file to remove the access that 
is provided by default. Locate the section that provides directory options for the htdocs directory. 
Either remove the Indexes option from the Options directive or place a minus (-) in front of it. 
Restart Apache to put the change into effect.

9.1.10  Preventing Unauthenticated Template Access

Under certain very specific circumstances, it is possible for a user to view WebAccess template files 
from a Web browser without logging in to WebAccess. There is no confidential information located 
in any of the template files that are accessible in this manner. 

Starting with GroupWise 6.5 Support Pack 4, a line was added to the webacc.cfg file to prevent 
such access:
19
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Templates.requireAuthentication=true

With this setting, unauthenticated users have no access to any WebAccess template files except for 
the Login page. If you have customized WebAccess templates for your own specialized use, this 
setting causes your templates to be inaccessible, even if GroupWise authentication was not 
previously required. You can turn off the authentication requirement by changing the line in the 
webacc.cfg file to:

Templates.requireAuthentication=false

9.1.11  Updates to WebAccess Templates

If you have created your own customized versions of the WebAccess send.inc and 
msgitem.htt templates, you need to make the following changes to these files in order for them 
to be compatible with GroupWise 7:

• Do not use the Url.Item.Reply.to and Url.Item.Reply.cc variables to pass and post names in a 
reply message's To and CC fields. Instead, use Item.toFullID and Item.ccFullID (or 
Item.toName or Item.ccName).

• When issuing an Item.Read action for a reply, set the Item.Reply parameter to either “sender” 
(to reply only to the sender) or “all” (to reply to all).

9.1.12  GroupWise 6.5 Frame Templates No Longer Supported

In GroupWise 7, the GroupWise 6.5 frame template files were still included in the GroupWise 7 
software image. Some users for whom the GroupWise 7 WebAccess client performance was 
unacceptably slow returned to using the GroupWise 6.5 frame template files in their GroupWise 7 
WebAccess installations.

Because the performance issues in the WebAccess client have been resolved in GroupWise 7 SP1, 
the Installation program does the following when you install the SP1 WebAccess software:

• Deletes the frames entry from the user interfaces list (ConsoleOne > WebAccess Application 
object > Application > Templates > Define User Interfaces). 

• Resets the default user interface to Standard HTML using the css templates.
• Moves the GroupWise 6.5 template files into a backup directory.
• Installs the new css template files to the templates directory of your Web server.

If you were using the GroupWise 6.5 frame templates with your GroupWise 7 installation, please do 
not continue to do so.

9.1.13  All-Day Events on a Wireless Device

If you create and send an all-day event from your wireless device, it displays as a one-minute 
appointment in the GroupWise Calendar.

9.1.14  “The Page Cannot Be Displayed” Error

On older versions of Internet Explorer, users might receive this message after the WebAccess 
software has been updated. See TID 10081268 (http://www.novell.com/inc/pf/pf.jsp?url=http://
support.novell.com/cgi-bin/search/searchtid.cgi?10081268.htm) for  instructions to correct the 
problem. Update to the latest version of Internet Explorer to avoid the problem.
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9.1.15  Blank WebAccess Address Book on Internet Explorer

On Internet Explorer, when you exit from Address Book Options in the WebAccess Address book, 
the Address Book page might be blank. Press F5 (Refresh) to redisplay the Address Book.

9.1.16  Folder List Expansion Problem in Safari on Macintosh

In Safari* on Macintosh, if you expand the folder list in the left panel to the point where the last 
folder in the list expands beyond the bottom of the page, the message list disappears from the right 
panel where it belongs and repositions in the right corner of the folder panel on the left.

To resolve the problem immediately, collapse the folder list so that it no longer extends beyond the 
bottom of the page, then log out of the WebAccess client and log back in again. To resolve the 
problem permanently, create a folder at the bottom of the folder list that does not have subfolders 
and therefore does not expand.

9.1.17  Document Viewer Agent Cache Compatibility

The cache created by the Document Viewer Agent is not compatible with the cache previously used 
with WebPublisher. Old WebPublisher cache directories should be removed from servers where the 
Viewer Agent is installed.

9.1.18  Document Viewer Agent /template Switch

The Document Viewer Agent startup file (gwdva.dva) lists a /template startup switch that is not 
yet implemented.

9.2  NetWare/Windows WebAccess Issues
• “WebAccess Installation Error on Windows Workstations” on page 21
• “WebAccess Service Fails to Start on Windows Servers” on page 22
• “Novell iManager Compatibility on Windows” on page 22
• “WebAccess Stops Responding on NetWare” on page 22
• “GroupWise 6.5 Upgrade on NetWare” on page 22
• “New NetWare and Windows WebAccess URLs” on page 22
• “Web Server File Cleanup Because of a URL Change” on page 23
• “Problem Downloading Large Attachments” on page 24
• “Memory Problem” on page 24
• “Security Issue with WebAccess and Internet Explorer 5.0” on page 24
• “Viewer Agent Issues on NetWare” on page 24

9.2.1  WebAccess Installation Error on Windows Workstations

If you receive an error during installation indicating that the nvweb.dll file cannot be found, 
update the workstation to the latest Novell Client. The Novell Client is available for download from 
the Novell Downloads Web site (http://download.novell.com).
21
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9.2.2  WebAccess Service Fails to Start on Windows Servers

If you install the WebAccess Agent as a Windows service, reboot the server, and then do a 
workstation login as an Administrator, the WebAccess Agent service might fail to start. If this 
occurs, update to the latest Novell Client. The Novell Client is available for download from the 
Novell Downloads Web site (http://download.novell.com).

9.2.3  Novell iManager Compatibility on Windows

If WebAccess and Novell iManager are installed on the same Windows 2000/2003 server, iManager 
might stop working. Because WebAccess installs and configures its own Tomcat and Jakarta 
connector, it is preferable to install it on a server where Tomcat is not already in use.

9.2.4  WebAccess Stops Responding on NetWare

WebAccess might stop responding for a period of time on NetWare. It might resume operation or it 
might not. To resolve this problem, update to the latest WINSOCK patch available in TID 2973892 
(http://support.novell.com/cgi-bin/search/searchtid.cgi?/2973892.htm).

9.2.5  GroupWise 6.5 Upgrade on NetWare

If the GroupWise 6.5 WebAccess Application is running on the server where you plan to install 
GroupWise 7 WebAccess, you should manually stop WebAccess, the Web server, and Tomcat before 
starting the GroupWise 7 installation. Under certain circumstances, the WebAccess Installation 
program cannot stop them for you.

9.2.6  New NetWare and Windows WebAccess URLs

Existing users of WebAccess are accustomed to accessing the following URLs on NetWare and 
Windows Web servers:

The WebAccess URLs on NetWare and Windows Web servers are now the same as the URLs used 
on Linux:

To keep users' browser bookmarks from being broken, you should redirect the old URLs to the new 
URLs. Follow the instructions below for your Web server.

Web Services page: Default index.html file of the Web server

WebAccess: http://web_server_address/servlet/webacc

WebPublisher: http://web_server_address/servlet/webpub

GroupWise-specific 
Web Services page: 

http://web_server_address/gw/index.html

WebAccess: http://web_server_address/gw/webacc

WebPublisher: http://web_server_address/gw/webpub
OOK TITLE

http://download.novell.com
http://support.novell.com/cgi-bin/search/searchtid.cgi?/2973892.htm


novdocx (E
N

U
)  01 February 2006
Apache

1 Change to the conf subdirectory of the Apache root directory (for example, 
\apache2\conf.

2 Edit the Apache configuration file for GroupWise.
On NetWare 6, the Apache configuration file is gwapache.conf. On NetWare 6.5, the 
Apache configuration file is gwapache2.conf.

3 Add the following line:
redirect permanent /servlet/webacc http://web_server_address/
                                                            gw/webacc 

4 If you use WebPublisher, add the following additional line:
redirect permanent /servlet/webpub http://web_server_address/
                                                            gw/webpub 

5 Save the file, then exit the editor.
6 Restart Apache to put the redirections into effect.

Internet Information Server (IIS)

1 Change to the inetpub\wwwroot subdirectory of the IIS root directory (for example, 
c:\inetpub\wwwroot)

2 Create a subdirectory named servlet.
3 Under the servlet subdirectory, create subdirectory named webacc.
4 If you use WebPublisher, create a second subdirectory named webpub.
5 In IIS Manager, expand the tree in the left pane to display Default Web Site under Web Sites.

Under Default Web Sites, you should see the servlet subdirectory you created in Step 2.
6 Expand the servlet subdirectory to display the webacc subdirectory (and optionally, the 
webpub subdirectory) that you created in Step 3.

7 Right-click the webacc subdirectory, then click Properties.
8 Click Directory, select A Redirection to a URL, then type /gw/webacc in the associated field.
9 Select A Permanent Redirection for This Resource, then click OK to save your changes.

10 If you use WebPublisher, repeat Step 7 through Step 9, using webpub in place of webacc.
11 Restart the IIS Web server to put the redirections into effect.

Netscape Enterprise Server for NetWare

For redirection instructions, search the Novell Support Web site (http://support.novell.com).

9.2.7  Web Server File Cleanup Because of a URL Change

As part of the change from /servlet/webacc to /gw/webacc, the WebAccess Installation 
program installs the WebAccess Application files into the servlet container (gw) but it does not 
remove old servlet and htdoc files located under the ROOT container of the servlet and the Web 
server. Therefore, you might want to manually delete the following directories and files:

sys:\apache2\htdocs\com
sys:\apache2\htdocs\index.html (if customized for GroupWise)
23
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sys:\apache2\htdocs\novell.html (if index.html was not customized)
sys:\tomcat\4\webapps\ROOT\WEB-INF\classes\com
sys:\tomcat\4\webapps\ROOT\WEB-INF\lib\ldapfilt.jar
sys:\tomcat\4\webapps\ROOT\WEB-INF\lib\ldapjdk.jar
sys:\tomcat\4\webapps\ROOT\WEB-INF\lib\njgwap.jar
sys:\tomcat\4\webapps\ROOT\WEB-INF\lib\njweb.jar
sys:\tomcat\4\webapps\ROOT\WEB-INF\lib\SpellServlet.jar
sys:\tomcat\4\webapps\ROOT\WEB-INF\web.xml

The one file you should definitely delete is web.xml, because might cause the WebAccess, 
WebPublisher, and Monitor Applications to run in both the old and new locations. Also, if you have 
customized the GroupWise template files, you should copy the contents of the template 
subdirectories under:

sys:\tomcat\4\webapps\ROOT\WEB-INF\classes\com\novell

to the corresponding templates subdirectories under:

sys:\tomcat\4\webapps\gw\WEB-INF\classes\com\novell

9.2.8  Problem Downloading Large Attachments

On NetWare 6.5 Support Pack 5, you might need to install a Winsock patch that enables users to 
download large attachments when they are using SSL connections to WebAccess. 

9.2.9  Memory Problem

On NetWare 6.5 Support Pack 5, you might receive one of the following error messages on the 
server where the WebAccess Agent is running:

Server logical address space is running low ...
Short term memory allocator is out of memory ...
Cache memory allocator out of available memory ...

A patch for this problem is available in TID 2973639 in the Novell Knowledgebase (http://
support.novell.com/search/kb_index.htm).

9.2.10  Security Issue with WebAccess and Internet Explorer 5.0

When using Internet Explorer 5.0 to view messages through WebAccess, URLs to messages become 
part of the History cache and can be read by other users who have access to the same workstation. 
For solutions to this problem, see TID 10056452 in the Novell Knowledgebase (http://
support.novell.com/search/kb_index.htm).

9.2.11  Viewer Agent Issues on NetWare

• On NetWare, the Viewer Agent requires at least 1 GB of memory for running about 5 worker 
processes. By default, 5 processes are started.

• On NetWare, you must install the latest Support Pack for your version of NetWare in order to 
have the correct version of clib.nlm. 

• On NetWare, Memory Protection Fault Cleanup must be set to On in order for the Viewer 
Agent worker processes to recover successfully when a document fails HTML conversion.
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• On NetWare, when a document fails HTML conversion and its worker process dies, NetWare 
creates a small file named core*.dmp in the server's root directory. You should periodically 
delete these files.

9.3  Linux WebAccess Issues
• “Novell Distribution of Apache and Tomcat” on page 25
• “Prolonged “Please Wait” Message during Installation” on page 26
• “Installation Security” on page 26
• “Re-installation Issue” on page 26
• “--httpport Switch Not Listed in webac70a.waa File” on page 26
• “Viewer Agent Issues on Linux” on page 26
• “WebPublisher Configuration” on page 27
• “WebPublisher Template Settings Not Saved” on page 27
• “Commented Lines in Configuration Files” on page 27
• “WebAccess Client Help Displays Incorrectly in Firefox on Linux” on page 27

9.3.1  Novell Distribution of Apache and Tomcat

GroupWise 7 on Linux includes a Novell distribution of Apache and Tomcat that you can install 
along with the WebAccess Application if you do not already have Apache and Tomcat running on 
that server. The Novell distribution relies on OpenSSL libraries. If OpenSSL is not already installed 
on the server where you plan to install the Novell distribution of Apache and Tomcat, you can obtain 
it from the OpenSSL Project (http://www.openssl.org). Download and build OpenSSL for your 
version of Linux before installing the Novell distribution of Apache and Tomcat.

The Novell distribution is installed in the following directories:

and is started using the following customized commands:

The WebAccess Installation program lets you choose whether you want to install the Novell 
distribution. During installation, select Install WebAccess Application with Apache and Tomcat if 
you want to install the Novell distribution. Select Install WebAccess Application if you do not want 
to install the Novell distribution of Apache and Tomcat because you have an existing Apache and 
Tomcat installation that you want to use with WebAccess.

NOTE: If you are installing on Novell Open Enterprise Server (OES), the option to install with 
Apache and Tomcat is not available.

Apache: /var/opt/novell/http and 
/etc/opt/novell/http

Tomcat: /var/opt/novell/tomcat4 and 
/etc/opt/novell/tomcat4

Tomcat: /etc/init.d/novell-tomcat4 start

Apache: /etc/init.d/novell-httpd start
25
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If you install the Novell distribution on a server where a standard distribution of Apache and Tomcat 
is already installed and running, you will encounter a port conflict on port 80. You can resolve the 
port conflict by choosing to run one distribution or the other, or you can reconfigure one distribution 
or the other.

To reconfigure the Novell distribution to use a different port number, edit the httpd.conf file in 
the /etc/opt/novell/httpd/conf directory. Locate the following line:

Listen 80

Change the port number to a something that is not already being used on the server, then save and 
exit the file.

9.3.2  Prolonged “Please Wait” Message during Installation

On slower Linux machines, if you select Install WebAccess Application with Apache and Tomcat, 
your machine might appear to hang on the “Please Wait” message. Apache and Tomcat are 
being installed while the “Please Wait” message is displayed, before the WebAccess 
Application installation begins.

9.3.3  Installation Security

During installation, the Linux WebAccess Installation program requires access to eDirectory by way 
of LDAP authentication. The LDAP Group object includes an option named Require TLS for Simple 
Binds with Password, which is enabled by default. With this option enabled, you must provide the 
LDAP server's trusted root certificate, which must be exported from the LDAP server, in order for 
LDAP authentication to take place (typically on port 636) during installation of the WebAccess.

Unless you already have SSL set up, an easier alternative is to disable Require TLS for Simple Binds 
with Passwords in ConsoleOne, which allows LDAP authentication to take place using clear text 
(typically on port 389), during installation of WebAccess. After disabling the option, restart 
eDirectory, install WebAccess, then re-enable Require TLS for Simple Binds with Password and 
restart eDirectory again.

9.3.4  Re-installation Issue

If you install Linux WebAccess in an eDirectory context where the WebAccess objects already exist, 
a message informs you that you can “use the existing objects.” In actuality, the objects are deleted 
and re-created, so if you have customized the properties of the existing objects, you must customize 
the objects again after installing WebAccess on Linux. 

9.3.5  --httpport Switch Not Listed in webac70a.waa File

The -httpport switch has been added to the Linux WebAccess Agent to specify the port number for 
HTTP communication. However, it is currently not listed in the webac70a.waa file on Linux.

9.3.6  Viewer Agent Issues on Linux

• On Linux, if you run the Viewer Agent as a user that is not running The X Window system, 
then WebAccess client users cannot view embedded vector-based graphics in attachments. To 
enable users to view embedded vector-based graphics, make sure that the user that starts 
WebAccess (and hence, the Viewer Agent) is running The X Window System and has a 
DISPLAY environment variable set so that the Viewer Agent can write to the local display. One 
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way to accomplish this is to use the sux command to become root before you start the 
WebAccess Agent.

• On Linux, the third-party viewer software used by the Viewer Agent has a dependency on 
libXm.so.1, which might not be included with your Linux package. To resolve this, create a 
symbolic link in the agents lib directory to the version of the libXm modules that is available 
on your Linux server. For example:
ln -s /usr/X11R6/lib/libXm.so.3.0.1 /opt/novell/groupwise/
                                               agents/lib/libXm.so.1

9.3.7  WebPublisher Configuration

The WebAccess Installation program does not configure WebPublisher for you. Some manual 
configuration is required. For instructions, see the GroupWise 7 Installation Guide (/docs/us/
GroupWiseInstallationGuide.pdf).

9.3.8  WebPublisher Template Settings Not Saved

Changes to the settings on the Templates page of the GroupWiseWebPublisher object in 
ConsoleOne are not saved to the webpub.cfg file. To work around this, after making changes on 
the Templates page, select a different property page on the GroupWiseWebPublisher object, then 
click OK or Apply to save the template settings correctly.

9.3.9  Commented Lines in Configuration Files

If you have commented out any lines in the Linux WebAccess configuration file (webacc.cfg) or 
the WebPublisher configuration file (webpub.cfg), you should back up those files before 
installing GroupWise 7. If you use the Configure WebAccess Application option in the Installation 
program, those commented lines become uncommented and the settings return to their defaults. 
However, any other changes you have made to the configuration files are retained. You must 
comment out the lines again and edit the settings as needed, using the backup copies for reference.

9.3.10  WebAccess Client Help Displays Incorrectly in Firefox on Linux

In Firefox* on Linux, the horizontal scroll bar in the left panel of the WebAccess client help displays 
in the middle of the column instead of at the bottom. It does not interfere with help functionality.

10  Internet Agent Issues
• Section 10.1, “General Internet Agent Issues,” on page 27
• Section 10.2, “NetWare/Windows Internet Agent Issues,” on page 28
• Section 10.3, “Linux Internet Agent Issues,” on page 28

10.1  General Internet Agent Issues
• “/copyonly Startup Switch Doesn’t Update the Database Version” on page 28
• “Address Resolution Change Since GroupWise 6” on page 28
27
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10.1.1  /copyonly Startup Switch Doesn’t Update the Database Version

If you use the /copyonly startup switch on the Internet Agent Installation program to install the 
GroupWise 7 SP1 Internet Agent software, the database version on the GWIA object does not get 
updated. As a result, the SP1 enhancement described in “Consolidated Configuration Information” 
in “What’s New in GroupWise 7” in the GroupWise 7 Installation Guide (http://www.novell.com/
documentation/gw7) does not occur. Therefore, you should not use the /copyonly startup switch 
when updated existing Internet Agent installation to GroupWise 7 SP1.

10.1.2  Address Resolution Change Since GroupWise 6

In GroupWise 6 and its Support Packs, there was a problem with the address format used for sending 
to distribution lists and resources if you set Internet Addressing to one of the following formats 
(which are not appropriate for distribution lists and resources):

• first_name.last_name@Internet_domain
• last_name.first_name@Internet_domain

Messages to distribution lists and resources were initially undeliverable and were sent to the Internet 
Agent. The Internet Agent then successfully resolved the addresses and sent the messages back into 
the GroupWise system. Users did not notice the problem, but some administrators noticed 
unnecessary traffic through the Internet Agent.

In GroupWise 6.5, the address format problem for sending to distribution lists and resources was 
corrected. However, users who originally used GroupWise 6 have the erroneous address format for 
distribution lists and resources in their Frequent Contacts address books. If you are updating from 
GroupWise 6 to GroupWise 7 and unnecessary traffic through the Internet Agent is a continuing 
problem, have users delete distribution lists and resources from their Frequent Contacts address 
books so that the correct address format is used for name completion in the future.

10.2  NetWare/Windows Internet Agent Issues
None.

10.3  Linux Internet Agent Issues
• “Obsolete grpwise-ia Script” on page 28
• “Installation Security” on page 28
• “libXm.so.3 Error” on page 29

10.3.1  Obsolete grpwise-ia Script

GroupWise 6.5 included the /etc/init.d/grpwise-ia script for starting and stopping 
the Linux Internet Agent. In GroupWise 7, the Internet Agent is started along with the POA and the 
MTA, using the grpwise script. Therefore, you should delete the obsolete grpwise-ia script from 
/etc/init.d so that it is not used inadvertently.

10.3.2  Installation Security

During installation, the Linux Internet Agent Installation program requires access to eDirectory by 
way of LDAP authentication. The LDAP Group object includes an option named Require TLS for 
Simple Binds with Password, which is enabled by default. With this option enabled, you must 
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provide the LDAP server's trusted root certificate, which must be exported from the LDAP server, in 
order for LDAP authentication to take place (typically on port 636) during installation of the Internet 
Agent.

Unless you already have SSL set up, an easier alternative is to disable Require TLS for Simple Binds 
with Passwords in ConsoleOne, which allows LDAP authentication to take place using clear text 
(typically on port 389), during installation of the Internet Agent. After disabling the option, restart 
eDirectory, install the Internet Agent, then re-enable Require TLS for Simple Binds with Password 
and restart eDirectory again.

10.3.3  libXm.so.3 Error

If you try to start the Linux Internet Agent using the --show switch on a server where The X Window 
System and Open Motif are not running, you receive the following error:

libXm.so.3: cannot open shared object file
: no such file or directory

To resolve the error, start The X Window System and Open Motif before starting the Internet Agent 
with the --show switch. If you start the Internet Agent without the --show switch, you can use the 
Internet Agent Web console to monitor the Internet Agent from your Web browser.

11  Monitor Issues
• Section 11.1, “General Monitor Issues,” on page 29
• Section 11.2, “Windows Monitor Issues,” on page 29
• Section 11.3, “Linux Monitor Issues,” on page 30

11.1  General Monitor Issues
• “Restoring Monitor Settings after Reinstallation” on page 29
• “Monitor Agent SSL Configuration” on page 29

11.1.1  Restoring Monitor Settings after Reinstallation

Monitor settings are stored in the monitor.xml file in the Monitor installation directory. Agent 
groups are also stored in this file. If you reinstall the Monitor software, the monitor.xml file is 
backed up as monitor.001. To restore previous Monitor settings and agent groups, remove the 
newly installed monitor.xml file and rename monitor.001 to monitor.xml.

11.1.2  Monitor Agent SSL Configuration

If you want to enable SSL using the Monitor Agent /httpssl and /httpcertfile switches, the certificate 
file must be in PEM format. This differs from the other GroupWise agents, which take a .b64 
public certificate file and a .key private key file. The PEM format combines the certificate and key 
in a single file.

11.2  Windows Monitor Issues
• “New NetWare and Windows Monitor URLs” on page 30
29
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11.2.1  New NetWare and Windows Monitor URLs

If you've used Monitor on a NetWare or Windows Web server, you are accustomed to accessing the 
following URLs:

 

Starting in GroupWise 7, use the following URLs on NetWare and Windows Web servers:

To keep users' browser bookmarks from being broken, you should redirect the old URLs to the new 
URLs. Follow the instructions in Section 9.2.6, “New NetWare and Windows WebAccess URLs,” 
on page 22, substituting /gw/gwmonitor for /gw/webacc as needed in the instructions.

11.3  Linux Monitor Issues
• “Monitor Issues Shared with WebAccess” on page 30

11.3.1  Monitor Issues Shared with WebAccess

Monitor and WebAccess share a substantial amount of functionality. The following WebAccess 
issues also pertain to Monitor:

Section 9.3.1, “Novell Distribution of Apache and Tomcat,” on page 25
Section 9.3.2, “Prolonged “Please Wait” Message during Installation,” on page 26
Section 9.3.3, “Installation Security,” on page 26
Section 9.3.4, “Re-installation Issue,” on page 26

12  International Issues
• Section 12.1, “General International Issues,” on page 30
• Section 12.2, “NetWare/Windows International Issues,” on page 31
• Section 12.3, “Linux International Issues,” on page 32

12.1  General International Issues
• “Double-Byte Characters in Directory Names and Filenames” on page 31
• “Double-Byte Characters in Passwords” on page 31
• “Character Encoding in WebAccess” on page 31
• “WebAccess Spell Checker Displays Corrupt Characters for Russian” on page 31
• “WebAccess Attachments with Extended Characters in the Filenames” on page 31

Web Services page: Default index.html file of Web server

Monitor Web Console: http://web_server_address/servlet/gwmonitor

GroupWise-specific Web 
Services page:

http://web_server_address/gw/index.html

Monitor Web Console: http://web_server_address/gw/gwmonitor
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12.1.1  Double-Byte Characters in Directory Names and Filenames

Do not use double-byte characters in directory names and filenames.

12.1.2  Double-Byte Characters in Passwords

Do not use double-byte character in users' passwords. 

The Change GroupWise Password dialog box in ConsoleOne currently allows entry of double-byte 
characters. However, the GroupWise client login does not allow entry of double-byte characters in 
passwords, so a user who was assigned a password with double-byte characters in ConsoleOne 
cannot type the double-byte characters when attempting to log in to GroupWise.

12.1.3  Character Encoding in WebAccess

Auto-detection of character encoding for the WebAccess/WebPublisher index.html page does 
not work for some Web browsers. If you do not see the localized languages in the drop-down menu 
on the Web services page (index.html), set your Web browser's character encoding to UTF-8. In 
some browsers, you can click View > Encoding to set the Web browser's encoding.

You might also encounter character encoding problems when reading HTML-formatted messages. 
In this case, set your Web browser's character encoding for the new message window to UTF-8. You 
can do this by right-clicking in the new message window and then setting the encoding, or by 
clicking View > Encoding.

12.1.4  WebAccess Spell Checker Displays Corrupt Characters for Russian

When Russian characters are used, they are displaying in the Spell Checker as corrupt characters.

12.1.5  WebAccess Attachments with Extended Characters in the Filenames

On Windows, Mozilla*-based browsers such as Firefox and Netscape* do not save extended 
character filenames correctly, even though the filename displays correctly in the Save As dialog box. 
This is a browser problem, not a GroupWise problem. There is no workaround.

In Safari on Macintosh, extended character filenames are not interpreted correctly. As a workaround, 
use Firefox instead of Safari if you receive attachments with extended character filenames. Again, 
this is a browser problem, not a GroupWise problem. 

12.2  NetWare/Windows International Issues
• “Print Calendar Language” on page 31
• “Japanese Viewers for WebAccess” on page 32

12.2.1  Print Calendar Language

The GroupWise client Print Calendar feature always prints calendars in the language specified in 
Regional Options or Regional Settings in the Control Panel, even if the client is installed in a 
different language. For example, if French (Switzerland) or French (Swiss) is specified in the 
Control Panel and the client is installed in German, calendars print in French.
31
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12.2.2  Japanese Viewers for WebAccess

In the WebAccess client running on Japanese Windows XP, some characters might not display 
correctly.

12.3  Linux International Issues
• “Display Problem with Agent Console Interfaces” on page 32
• “Russian Keyboard” on page 32
• “Mnemonics for Arabic, Hebrew, and Double-Byte Languages” on page 33
• “Localized Agent User Interface Display” on page 33

12.3.1  Display Problem with Agent Console Interfaces

If you run the Linux GroupWise agents with an agent console interface in languages other than 
English, the display of logging information might not display correctly. The problem occurs if your 
language encoding is set to UTF-8.

To determine your current language encoding, use the following command in a terminal window:

locale

You can change your language encoding in YaST:

1 Start YaST, click System, then double-click Choose Language.
2 Select the language you are running the agents in, then click Details.
3 Deselect Use UTF-8 Encoding, then click OK.
4 Stop and then restart the agents to put the new setting into effect.

12.3.2  Russian Keyboard

When you use a Russian keyboard, the Linux environment variables that provide language and 
locale information are typically set to ru_RU. Typically, this setting implies the Russian character 
set ISO-8859-5. However, on some distributions of Linux, the ISO-8859-5 character set must be set 
explicitly in order for your Russian keyboard to work with the GroupWise Cross-Platform client. 
Use the following command to specify the character set along with the language and locale 
information:

export LANG=ru_RU.ISO-8859-5

In most cases, setting the LANG environment variable also sets all LC_* environment variables and 
resolves all Russian keyboard problems. If you set the LANG environment variable and your 
Russian keyboard still does not work, use the following command to view the current settings for 
the LANG and LC_* environment variables:

locale

If any of the LC_* environment variables have not inherited the ISO-8859-5 specification, export 
them individually.
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12.3.3  Mnemonics for Arabic, Hebrew, and Double-Byte Languages

Keyboard mnemonics for menu items work for characters a-z and A-Z, but not for other characters.

12.3.4  Localized Agent User Interface Display

The Linux GroupWise agent user interfaces display correctly if the Linux environment is using the 
ISO-8859-1 character set, which is the default for the GroupWise administration languages and 
locales.

French: fr_FR
German: de_DE
Portuguese: pt_BR
Spanish: es_ES

If the Linux environment is using a different character set encoding such as UTF-8 (for example, 
fr_FR.UTF-8), the localized agent user interfaces do not display correctly.

13  Documentation Issues
• Section 13.1, “General Documentation Issues,” on page 33
• Section 13.2, “NetWare/Windows Documentation Issues,” on page 33
• Section 13.3, “Linux Documentation Issues,” on page 33

13.1  General Documentation Issues
None.

13.2  NetWare/Windows Documentation Issues
• “GroupWise Windows Client Help” on page 33

13.2.1  GroupWise Windows Client Help

To support accessibility requirements within GroupWise Help, the Help for the GroupWise 
Windows client uses Microsoft HTML Help. In order for Microsoft HTML Help to display on a 
Windows workstation, the workstation must have Internet Explorer 4.x or later installed.

13.3  Linux Documentation Issues
• “Agent Help Does Not Display When Agent Runs as a Non-root User” on page 33
• “Help Image Display on an iChain Server” on page 34

13.3.1  Agent Help Does Not Display When Agent Runs as a Non-root User

When you start the Linux POA, the Linux MTA, and the Linux Internet Agent using the --show 
switch to display a GUI user interface, if the agents are running as a non-root user, clicking Help 
does not display the agent help file. Help is displayed in a browser window and the agents currently 
launch the browser as root. Giving the user access to the browser window as root would be a 
security risk. This is working as designed.
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13.3.2  Help Image Display on an iChain Server

If you display help from an agent Web console on a server where Novell iChain® is installed, and if 
iChain is configured to use the Path-Based Multihoming option, the image at the top of the help 
topic does not display.

14  GroupWise Defect Fixes
• Section 14.1, “Address Book Fixes,” on page 34
• Section 14.2, “Administration Fixes,” on page 34
• Section 14.3, “Agent Fixes,” on page 35
• Section 14.4, “Client Fixes (Windows),” on page 35
• Section 14.5, “Client Fixes (Cross-Platform),” on page 37
• Section 14.6, “Client API Fixes,” on page 38
• Section 14.7, “Engine Fixes,” on page 38
• Section 14.8, “GWCheck Fixes,” on page 39
• Section 14.9, “Internet Agent Fixes,” on page 39
• Section 14.10, “Monitor Fixes,” on page 39
• Section 14.11, “WebAccess Fixes,” on page 39

14.1  Address Book Fixes
• You can send messages to recipients whose names include extended characters. 
• You can send messages to internal recipients who are not in your Frequent Contacts address 

book. 
• When you create a personal group that includes recipients in the To, CC, and BC fields,  the 

recipients retain their respective recipient types when you select the group in the To field of a 
new message. 

• The absence of the Object ID attribute in the GroupWise Address Book no longer causes Name 
Completion to stop working in the GroupWise client. 

14.2  Administration Fixes
• When you specify the path for a trusted root certificate for an LDAP server, the path is stored 

permanently as a UNC path. 
• If you set a global signature at the domain or post office level, you can set it to <None> at the 

user level. 
• You can select an Internet domain name for a nickname. 
• In a system with two Internet domain names and two identical mailbox IDs in different post 

offices, you can override the default address formats for each user without getting a DB57 
error. 

• After you move a user, the user’s Unread Items panel in the GroupWise Windows client 
correctly displays only unread items. 

• You can successfully move a user whose visibility is set to None. 
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• You can successfully move a very old user that has a two-character FID. 
• When you move a user from a GroupWise 6.5 post office to a GroupWise 7 post office, the 

final Move Completed message now displays. 
• If you rebuild a database when running ConsoleOne as root, it does not interfere with running 

the agents as a non-root user thereafter. 
• You can merge a GroupWise 6.5 domain into a GroupWise 7 system. 
• In the Link Configuration Tool, pressing Cancel discards changes as it should. 
• The functionality of the selection list in the GroupWise Target Service Agent for File Systems 

(TSAFSGW) has been improved. 
• In Linux ConsoleOne, the restore area path is stored as a UNC path, not a Linux path. 
• In Linux ConsoleOne on SUSE Linux Enterprise Server 9, it is no longer possible to create 

duplicate GWIDs when adding users. 
• On Linux, the GroupWise Database Copy utility (DBCopy) runs successfully if the filename of 

the GroupWise guardian database (ngwguard.db) is in all uppercase (NGWGUARD.DB). 
• Improvements were made to the GroupWise Database Copy utility (DBCopy) on Linux to 

facilitate migration. 

14.3  Agent Fixes
• The POA can successfully access a restore area on a remove server regardless of the platform 

of the remote server. 
• The POA captures user information about who logged in through a trusted application. 
• If the Linux POA is running as a non-root user and a user creates a new document in a library, 

the POA indexes the document and the user can successfully use Find to search the document. 
• When running as a daemon, the Linux POA can access an LDAP server using an SSL 

connection. 
• Fixed some POA abends. 
• If the MTA is enabled for SSL on its MTP port but not its HTTP port, the MTP port works 

correctly with SSL. 
• Fixed several MTA abends. 
• The Linux grpwise script allows for running more than one of each type of GroupWise 

agent. 

14.4  Client Fixes (Windows)
• The column widths in your Home View are always retained after displaying other folders. 
• If you receive a message formatted in a large font, your reply uses your default font, not a very 

small font. 
• When you reply to a message, you signature is applied immediately below your reply text, not 

at the bottom of the entire message. 
• If you have configured the client to prompt you before adding your signature, the signature is 

always added when you click Add. 
• You can always view item properties in your archive. 
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• When you drag an attachment from a message to a folder, the file retains its original filename 
and file type. 

• You can multiple-select items to print. 
• Appointments sent to CC recipients default correctly to Free, rather than to Busy. 
• When you reschedule an appointment that has an attachment and perform a Busy Search to 

identify the new time, the attachments stays with the rescheduled appointment. 
• When you display a calendar that includes an All-Day Event, the event is confined to the day 

on which it is scheduled. 
• When you print a calendar that includes an All-Day Event, the event is confined to the day on 

which it is scheduled. 
• The client no longer displays an 8101 error when accessing a Calendar that includes an All-Day 

Event. 
• You can set categories on items in a shared folder if you have sufficient rights to do so. 
• You can view items in a shared folder immediately after viewing your Calendar. 
• You can show a posted tasks in the Checklist folder. 
• With the QuickViewer on,  you can scroll back and forth horizontally in a message that has a 

category assigned. 
• You can go from a very long Sent Items list to your Contacts folder without waiting for the 

entire Sent Items list to display. 
• The Spell Checker works correctly in very large HTML-formatted messages. 
• In Caching mode,  you always have the correct rights when you proxy into another user’s 

mailbox. 
• In Caching mode, with Messenger Presence turned on, in the QuickViewer, you can move 

rapidly between messages. 
• In Caching mode, you no longer receive a second notification if you open an item and then 

synchronize with your Online mailbox. 
• The GroupWise Address Book downloaded to your Caching mailbox does not become 

damaged. 
• If you perform another action without waiting for a Find to finish, the Find finishes in the 

background of your other activity. 
• The keystroke sequence for using Advanced Find opens a new field without needing a mouse 

click. 
• Messages  with a content type of Multipart/Related and Multipart/Alternative are accepted and 

displayed by the GroupWise client. 
• If you type HTML tags and text into a message in Plain Text mode, and if the recipient is in 

HTML mode, the message displays as an HTML-formatted message. 
• If you save an HTML-formatted message as a draft and if the message includes a path to an 

image where the path or the image filename includes a space, the path and filename are 
correctly displayed when you resume work on the draft message. 

• You can open a message from the Notify pop-up and then immediately close the GroupWise 
client. 

• You can reply to a message where the first character in the message is a dash (-). 
• If you have just one S/MIME certificate, it is automatically selected as the default. 
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• When using a MIME encoding other than the default, you can add an image to an HTML-
formatted message or signature without having it appear as an attachment much larger than the 
original image. 

• Third-party applications can attach mime.822 files to messages. 
• HTML-formatted messages display properly in other e-mail clients such as  AOL and HotMail. 
• When Firefox is set as your default browser, hyperlinked URLs open successfully. 
• On Windows XP, you can send a message from a Wordpad document using the GroupWise 

client. 
• Third-party applications  can log into GroupWise using the extended MAPI application  that 

ships with GroupWise. 
• The default client integrations file (gwappint.inf) has the correct  integration type for 

Excel. 
• Excel 2003 can be successfully integrated with GroupWise. 
• Installing GroupWise after installing Outlook no longer stops Outlook from functioning. 
• If you create a message in the GroupWise client, then click Actions > Send Using and select a 

POP account, the message is sent as if it originated in the selected POP account. 
• You can download messages from a POP e-mail client when attachment filenames include  

international characters. 
• When you update from GroupWise 6.5, you only need Read rights in the software distribution 

directory in order to run Setup. 
• In the Portuguese client, the subject and place information in a posted appointment displays 

correctly in the Calendar. 
• In languages such as Hebrew and Russian, clicking Reply or Forward in a message does not 

change the keyboard from the expected language. 

14.5  Client Fixes (Cross-Platform)
• In HTML view,  images display correctly. 
• HTML-formatted messages now have margins comparable to those used in the Windows client. 
• If a message contains a link to an image, the message displays successfully, without causing the 

GroupWise client to freeze. 
• Large messages that include numerous images print  successfully. 
• A hyperlinked URL that includes an e-mail address at the end is correctly interpreted as a URL 

and does not open a Mail To window. 
• A hyperlinked URL created in the GroupWise Windows client displays correctly when 

displayed in the HTML view in the Cross-Platform client. 
• If you highlight and move a block of items to a different folder, the highlight in the original 

folder  is positioned as expected. 
• Attachments are saved with the exact filename and extension specified in the Save File As 

field. 
• You can always drag an attachment from one message to another. 
• If you drag the same attachment to a message more than once (for example, you modified the 

file and want to attached the updated version), only one attachment displays in the message. 
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The actual attachment process happens when the message is sent, so the current version always 
gets attached. 

• You can successfully sent messages to recipients that you selected from an address book and 
who have Internet addresses associated with them. 

• Under Print Calendar,  if you select the Daily form and you select Appointments as a Table, 
Task and Reminder Notes as a List,  it prints the days selected on the Content tab. 

• The Checklist display option works correctly on any folder. 
• The password to the Caching mailbox never gets inadvertently cleared. 
• If you open a new GroupWise window and then proxy into another user’s mailbox, only the 

new windows changes to the proxy user’s mailbox. 
• The Search feature is more robust and does not crash under certain specialized circumstances. 
• Misspelled words are always properly highlighted. 
• The spell checker no longer hangs the Cross-Platform client on Novell Linux Desktop 9 SP3. 

14.6  Client API Fixes
• The client API returns the correct number when there are more than 65,535 records to count in 

the GroupWise Address Book. 
• The client API returns the correct number when there are more than 100 users in a distribution 

list. 
• The client API can successfully iterate through all the message-type attachments of a message 

in an archive, regardless of how nested the message attachments are. 
• The client API returns an appropriate error when it fails to proxy into another user’s account. 
• If the client API encounters a user-defined field in an entry in a user’s Contacts Address Book 

that is not of type text, it skips the non-text field. 
• When accessing a Message object, the client API accesses message attachments correctly. 
• The message body refreshes correctly. 
• Semaphores no longer deadlock. 
• Multiple threads no longer cause data corruption and deadlocks. 

14.7  Engine Fixes
• IMAP can handle folder names that include parentheses. 
• The IMAP FETCH command can handle some incorrectly formatted MIME messages without 

complaint. 
• The IMAP APPEND command can handle non-system keyword flags that are not the three 

predefined GroupWise flags. 
• The IMAP Search Header <field> <string> command works for most header 

fields. 
• GroupWise IMAP is compatible with the Pine e-mail program. 
• SOAP works properly on a multiprocessor server. 
• SOAP can handle logging in to a shared folder. 
• SOAP never releases the static global parent object, which increases stability. 
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• CAP no longer trims out the <CR><LF> at the end of a frame buffer. 
• CAP can handle a null category. 
• When converting UTF-8 to WPText, CAP no longer converts <LF> to <SP>. 
• CAP no longer returns a D107 error when reading the items returned from a read index. 

14.8  GWCheck Fixes
• GWCheck runs successfully on very large post offices. 
• On Macintosh, the GWCheck desktop icon starts GWCheck. 

14.9  Internet Agent Fixes
• The Internet Agent server console no longer becomes garbled with extraneous text. 
• If the Internet Agent receives a 4xx message on a DATA command from an SMTP host, it defers 

the message, rather than responding as if the message had been successfully received. 
• Authentication from IMAP e-mail clients through the Internet Agent occurs more quickly. 
• Messages with ISO-8859-15 encoding are processed correctly. 
• The Internet Agent can correctly process Internet domain names that contain dashes (-). 
• Messages that contain international characters in the x-spam-report field are processed 

successfully. 
• The Internet Agent now accepts messages where several MIME format issues were previously 

causing them to be placed in the gwprob directory. 
• The Internet Agent no longer returns messages to itself when it cannot resolve the hostname. It 

returns an Unknown Host error instead. 
• The Internet Agent no longer allocates unneeded .5 GB blocks of memory. 
• Fixed some Internet Agent abends. 

14.10  Monitor Fixes
• None.

14.11  WebAccess Fixes
• The first mouse click after you log in, after you change folders, and after a refresh successfully 

opens the message you clicked. 
• Users always get the proper templates when they click New. 
• In a new messages, the cursor focus is automatically in the To field. 
• Messages with embedded images display correctly. 
• When viewing item properties, the Display Next button displays correctly. 
• You can view documents in a shared folder. 
• Attachment filenames are correctly retained when viewing attachments. 
• Reply to All places all usernames in the correct fields with valid e-mail addresses. 
• The folder list retains folders as expanded or collapsed after various intervening actions. 
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• You can successfully drag and drop a large number of messages individually. 
• In the Calendar, when you click New, the default is New Appointment. 
• When you create a posted appointment in the Week view, it displays correctly as a posted 

appointment. 
• In the Day view in the Calendar, All Day Events display just on the day for which they are 

scheduled. 
• WebAccess installs much more quickly. 
• The WebAccess Agent no longer causes Java to go to 100% utilization. 
• The WebAccess Application reliably starts the Document Viewer Agent. 
• Fixed a WebAccess Agent abend. 
• Using Firefox, if you time out and then resume your session, you can successfully add 

attachments to a message that was in progress when you timed out. 
• On NetWare 6, the index.html file displays as it should. 
• WebAccess retains the proper character set when displaying messages. 
• If character set information is not available, WebAccess defaults to ISO-8859-15. 
• Name Completion looks for the Frequent Contacts Address Book in the correct language. 
• Users can add names to the Frequent Contacts Address Book in all languages. 

15  GroupWise Connector for Outlook
For installation instructions, known issues, and defect fixes relating to the GroupWise Connector for 
Microsoft Outlook, see the Support Pack 1 Readme for the GroupWise Connector for Microsoft on 
the GroupWise 7 Documentation Web site (http://www.novell.com/documentation/gw7).

16  GroupWise Mobile Server
For installation instructions, known issues, and defect fixes relating to GroupWise Mobile Server, 
Powered by Intellisync*, see the Support Pack 1 Readme for GroupWise Mobile Server on the 
GroupWise 7 Documentation Web site (http://www.novell.com/documentation/gw7).

17  Documentation
The following sources provide information about GroupWise 7 and have been updated for Support 
Pack 1:

• Product documentation included with the software in the \docs\us directory: 
• Quick Start (GroupWiseQuickStart.pdf)
• Installation Guide (GroupWiseInstallationGuide.pdf)

• Online product documentation: GroupWise 7 Documentation Web site (http://
www.novell.com/documentation/gw7) 

18  Documentation Conventions
In this documentation, a greater-than symbol (>) is used to separate actions within a step and items 
in a cross-reference path.
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A trademark symbol (® , TM, etc.) denotes a Novell trademark; an asterisk (*) denotes a third-party 
trademark

19  Legal Notices
Novell, Inc. makes no representations or warranties with respect to the contents or use of this 
documentation, and specifically disclaims any express or implied warranties of merchantability or 
fitness for any particular purpose. Further, Novell, Inc. reserves the right to revise this publication 
and to make changes to its content, at any time, without obligation to notify any person or entity of 
such revisions or changes.

Further, Novell, Inc. makes no representations or warranties with respect to any software, and 
specifically disclaims any express or implied warranties of merchantability or fitness for any 
particular purpose. Further, Novell, Inc. reserves the right to make changes to any and all parts of 
Novell software, at any time, without any obligation to notify any person or entity of such changes.

Any products or technical information provided under this Agreement may be subject to U.S. export 
controls and the trade laws of other countries. You agree to comply with all export control 
regulations and to obtain any required licenses or classification to export, re-export, or import 
deliverables. You agree not to export or re-export to entities on the current U.S. export exclusion 
lists or to any embargoed or terrorist countries as specified in the U.S. export laws. You agree to not 
use deliverables for prohibited nuclear, missile, or chemical biological weaponry end uses. Please 
refer to www.novell.com/info/exports/ for more information on exporting Novell software. Novell 
assumes no responsibility for your failure to obtain any necessary export approvals.

Copyright © 2006 Novell, Inc. All rights reserved. No part of this publication may be reproduced, 
photocopied, stored on a retrieval system, or transmitted without the express written consent of the 
publisher.

Novell, Inc. has intellectual property rights relating to technology embodied in the product that is 
described in this document. In particular, and without limitation, these intellectual property rights 
may include one or more of the U.S. patents listed at http://www.novell.com/company/legal/patents/ 
and one or more additional patents or pending patent applications in the U.S. and in other countries.

For Novell trademarks, see the Novell Trademark and Service Mark list (http://www.novell.com/
company/legal/trademarks/tmlist.html).

All third-party trademarks are the property of their respective owners.
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